
Debug ESP32S3 using ESP-IDF on VSCode 
Target hardware 

1. ESP32-S3 Super Mini Black Gold 

2. Clone of a ZERO board 

3. Has 18 pins, boot and reset bu$ons and a USB-C connector 

4. MCU is ESP32-S3 FH4R2 

5. Datasheet h$ps://www.espressif.com/sites/default/files/documenta0on/esp32-s3_datasheet_en.pdf 

6. CPU is Xtensa® dual-core 32-bit LX7 microprocessor 

7. Clock speed: up to 240 MHz 

8. Flash is 4Mb, PSRAM 2Mb and SRAM 512 Kb 

9. Assume USB JTAG/debug unit (interface 0) set as COM3 

10. Assume USB JTAG/debug unit (interface 2) configured as a Universal Serial Bus Device called USB JTAG/Serial 

debug unit 

 

  



USB Ports 

There are three types of ESP32xx modules with different number and types of USB ports. 

1. ESP32 has one standard COM port used for serial upload and prin0ng. 

2. ESP32-Sx mini has one USB port, which presents as: 

a. USB na0ve 

i. USB JTAG/serial debug unit (interface 0) with driver libwdi 1.0.0.0 reported by device 

manager and usbser 1.0.0.0 by Zadig.  Windows will allocate a COM port number e.g. COM4. 

ii. USB/JTAG serial debug unit (interface 2) with driver libwdi 6.1.7600.16386reported by device 

manager and WinUSB 6.1.7600.16386 by Zadig.  Windows will allocate as a Universal Serial 

Bus device called USB JTAG/serial debug unit.  If this device appears as a COM port use Zadig 

to change the driver to WinUSB. 

3. ESP32-Sx Dev kit has two USB ports called COM and USB, which present as: 

a. COM 

i. One standard COM port used for serial upload and prin0ng e.g. COM3. 

b. USB na0ve 

i. USB JTAG/serial debug unit (interface 0) with driver libwdi 1.0.0.0 reported by device 

manager and usbser 1.0.0.0 by Zadig.  Windows will allocate a COM port number e.g. COM4. 

ii. USB/JTAG serial debug unit (interface 2) with driver libwdi 6.1.7600.16386reported by device 

manager and WinUSB 6.1.7600.16386 by Zadig.  Windows will allocate as a Universal Serial 

Bus device called USB JTAG/serial debug unit.  If this device appears as a COM port use Zadig 

to change the driver to WinUSB. 

Configuring the USB ports 

1. Download and run the latest version of Zadig from h$ps://zadig.akeo.ie/ 

2. Click Op0ons and select list all devices 

3. USB JTAG/Serial debug unit (Interface 0) – check driver is a version of usbser, if not install USB Serial, which 

will appear in device manager as a COM port in the Ports (COM & LPT) sec0on. 

4. USB JTAG/Serial debug unit (Interface 2) – change driver to WinUSB or libusbK, which will appear as a USB 

Serial Bus device called USB JTAG/serial debug unit or USB JTAG/serial debug unit (Interface 2) in device 

manager under the sec0on libusbK USB devices.  For more info about libusbK devices see: 

h$ps://libusbk.sourceforge.net/UsbK3/index.html 

  



Install ESP-IDF 

1. Download the offline tools installer from h$ps://dl.espressif.com/dl/esp-idf/?idf=4.4 

a. Either a specific version, or use the universal online installer and choose the version 

2. During the installa0on two special shortcuts (CMD & PowerShell) will be added to the desktop  

a. Both shortcuts setup the Python environment ready for ESP-IDF commands 

b. I prefer PowerShell as can cd to a new path in one step 

 

3. Upda0ng ESP-IDF tools and adding ESP-IDF tools to PATH using an export script 

a. Open the PowerShell shortcut and run install.ps1 and then export.ps1 

b. Open the Command shortcut and run install.bat and then export.bat 

c. Look at the output and run any other sugges0ons for missing items 

  



ESP-IDF on VSCode configura"on 

1. The black line at the top of the editor pane can be turned on and off by opening the command pale$e (Menu 

> View > Command pale$e > Toggle Editor S0cky Scroll. 

IDF_PATH 

IDF_PATH is an environment variable that points to the ac0ve ESP-IDF folder and is used during opera0ons of the ESP-

IDF extension in VSCode and when using a CLI such as the PowerShell and CMD shortcuts added when installing ESP-

IDF tools. The following may be useful: 

1. The ESP-IDF extension on VSCode appears to set the IDF_PATH when required e.g. 

a. PS E:\Users\Steven\Documents\GitHub\ESP-IDF\test2> & set 

IDF_PATH='C:/Espressif/frameworks/esp-idf-v5.2.2/' 

2. The IDF_PATH can be set from an ESP-IDF terminal within the ESP-IDF extension using: 

a. Set IDF_PATH=’C:/Espressif/frameworks/esp-idf-v5.2.2/’ 

3. The IDF_PATH can be set from an ESP-IDF PowerShell or CMD window using: 

a. Set IDF_PATH=’C:/Espressif/frameworks/esp-idf-v5.2.2/’ 

4. The IDF_PATH can be permanently set by: 

a. Create a text file called export_idf_path.sh within C:\msys32\etc\profile.d containing the line export 

IDF_PATH="C:/msys32/home/user-name/esp/esp-idf" 

5. The IDF_PATH can be permanently set by: 

a. Use Windows search to find Edit Environment Variables and add a user, or system, variable called 

IDF_PATH with the contents C:\Espressif\frameworks\esp-idf-v5.2.2 note the back slashes. 

To view the IDF_PATH environment variable use: 

1. echo $Env:IDF_PATH in a ESP-IDF PowerShell windows, but not a CMD window! 

2. echo $Env:IDF_PATH from an ESP-IDF terminal within the ESP-IDF extension in VSCode 

3. echo %IDF_PATH% from an ESP-IDF CMD or normal Windows CMD window 

4. echo $IDF_PATH from an MSYS Bash terminal 

For more info see: h$ps://docs.espressif.com/projects/esp-idf/en/v3.3.5/get-started/add-idf_path-to-profile.html 

and h$ps://docs.espressif.com/projects/esp-idf/en/release-v3.3/get-started-cmake/add-idf_path-to-profile.html 

Install ESP-IDF extension on VSCode 

1. Start VSCode and go to extensions 

2. Search for and install the ESP-IDF extension 

3. Select a version of installed ESP-IDF to use e.g. 5.2.2 

4. From the commands sec0on select Configure ESP-IDF version and choose EXPRESS 

5. Choose Find ESP-IDF on My System as it has already been installed 

6. IDF_PATH should look like C:/Espressif/frameworks/esp-idf-v5.2.2/ 

7. IDF_TOOLS_PATH should look like c:\Espressif\tools 

8. Click install bu$on and wait for comple0on 

Crea"ng a new project from an example 

1. Click the ESP-IDF: EXPLORER icon in the primary side bar at the leX 

2. In COMMANDS click Show Examples and choose the IDF version 

3. Scroll down to e.g. peripherals > lcd > spi_lcd_touch 

4. Click the blue bu$on Create project using example spi_lcd_touch 

5. Save project in e.g. E:\Users\Steven\Documents\GitHub\ESP-IDF 

6. Ignore warning "e:\Users\Steven\Documents\GitHub\ESP-IDF\spi_lcd_touch 

/build/compile_commands.json" could not be parsed. 'includePath' from c_cpp_proper0es.json in folder 

spi_lcd_touch will be used instead as of course the build folder does not yet exist as the project has not 

been built! 

7. Do Menu > File > Close Folder 

8. Edit the name of the project folder to e.g. GC9A01_project and reopen using menu > file > open folder 

9. Set the COM port to e.g. COM3 



10. Set the target to e.g. esp32s3 and ESP32-S3 chip via buil0n USB-JTAG 

a. At this point any Managed Component folders are added 

11. Open Menuconfig idf.py menuconfig 

12. Search for FLASH and change flash size from 2MB to 4MB 

13. Change any other se[ngs as needed e.g. search for LCD and change LCD controller model to e.g. GC9A01 

14. Build the project – 963 steps! 

15. Select flash method UART or JTAG and flash the target 

Crea"ng a minimal new project 

1. Click the ESP-IDF: EXPLORER icon in the primary side bar at the leX 

2. In COMMANDS click Show Examples and choose the IDF version 

3. Click sample_project as it always works 

4. Click the blue bu$on Create project using example sample_project 

5. Save project in e.g. E:\Users\Steven\Documents\GitHub\ESP-IDF 

6. Ignore warning "e:\Users\Steven\Documents\GitHub\ESP-

IDF\sample_project/build/compile_commands.json" could not be parsed. 'includePath' from 

c_cpp_proper0es.json in folder 'SAMPLE_PROJECT' will be used instead as of course the build folder does not 

yet exist as the project has not been built! 

7. Do Menu > File > Close Folder 

8. Edit the name of the project folder to e.g. new_project and reopen using menu > file > open folder 

9. Set the COM port to e.g. COM3 

10. Set the target to e.g. esp32s3 and ESP32-S3 chip via buil0n USB-JTAG 

a. At this point any Managed Component folders are added 

11. Open Menuconfig idf.py menuconfig 

12. Search for FLASH and change flash size from 2MB to 4MB 

13. Change any other se[ngs as needed 

14. Build the project – 963 steps! 

15. Select flash method UART or JTAG and flash the target 

Libraries as Components 

1. The official source for libraries is the ESP Component Registry at: h$ps://components.espressif.com/ 

a. Searchable by keywords. 

b. Can be filtered by target MCU. 

c. GitHub components: h$ps://github.com/espressif/esp-idf/tree/master/components 

d. GitHub examples: h$ps://github.com/espressif/esp-idf/tree/master/examples 

e. The ESP Component Registry is also available from a link in the Welcome to Espressif IDF extension 

tab in ESP-IDF on VSCode. 

f. The ESP-IDF Component Manager and its use is described here: 

h$ps://docs.espressif.com/projects/esp-idf/en/latest/esp32/api-guides/tools/idf-component-

manager.html 

2. An alterna0ve ESP-IDF Components library for LCD and other hardware is at: 

h$ps://github.com/UncleRus/esp-idf-lib/tree/master and the searchable list is at: h$ps://esp-idf-

lib.readthedocs.io/en/latest/index.html 

Add Components (Libraries) to your project 

Note: There appears to be something wrong with the component espressif/led_strip 2.5.5 in that the Python 

command does not work and produces many error messages, but downloading and adding the component archive 

does work 

1. There are two methods to add a component to a project 

a. One involves running a Python command in an ESP-IDF terminal e.g. idf.py add-dependency 

"lvgl/lvgl^9.2.0"  which adds a Component Manager Manifest File in the main folder called 

idf_component.yml 



i. Then run idf.py reconfigure and/or idf.py update-dependencies in an ESP-IDF terminal, which 

adds the component into a new folder called managed_components 

ii. Next build the project before adding any includes 

b. If the first method does not work create a folder called components, in the projects folder, and the 

download and unzip the component archive into that new folder from 

h$ps://components.espressif.com 

i. Then run idf.py reconfigure and/or idf.py update-dependencies in an ESP-IDF terminal 

ii. Next build the project before adding any includes 

1. Expand the components folder in ESP-IDF Explorer, to see the component name added to the component 

folder; this does not apply to the managed _components folder 

2. Add any includes to main.c 

3. Build the project again 

Flashing problems 
1. Flash size on target is different to the size used to upload via JTAG.  The solu0on is open SDK 

Configura0on Editor (menuconfig) and search for “flash” then edit the flash size to match the target, for 

example: 

a. ESP32-S3 FH4R2 Mini = 4Mb 

b. ESP32-S3 Dev Kit N8R2 = 8Mb 

c. ESP32-S3 Dev Kit N16R8 = 16Mb 

If flashing via JTAG fails, change the flash method to UART and check working by building and flashing, then change 

the flash method back to JTAG and again check working by building and flashing. 

Viewing serial output 

1. The blink example prints Turning the LED ON! and Turning the LED OFF! 

2. To view open a serial terminal e.g. SmarTTY and connect to COM3 at 115200 baud 

3. Or just use the Build, Flash & Monitor icon to open a terminal in the ESP-IDF extension 



Debugging 

1. Click the Run & Debug icon in the leX pane, a triangle arrow and a beetle. 

a. If you don’t open Run & Debug and start debugging from elsewhere you may see nothing 

happening for a while and think it’s not working; with Run & Debug open you can see the startup 

of debugging. 

2. Click Menu >Run > Start debugging, or press F5 or click the green hollow arrow at the top near Eclipse 

CDT GDB adapter. 

3. Debug stops at the start of void app_main(void) and code execu0on can be single stepped, or con0nued, 

from there. 

So.ware breakpoints 
// Insert a breakpoint 

    __asm__("break 0,0"); // causes execu0on to stop and can not be stepped on further 

Logging 
ESP-IDF provides different log levels, each corresponding to a different severity, which are output on a COM port and 

can be viewed in a serial terminal, like the one built into VSCode: 

ESP_LOGE: Error messages 

ESP_LOGW: Warning messages 

ESP_LOGI: Informa0onal messages 

ESP_LOGD: Debug messages 

ESP_LOGV: Verbose messages 

Example code: 

#include "esp_log.h" 

sta0c const char *TAG = "example"; 

void app_main() { 

    int value = 42; 

    ESP_LOGI(TAG, "Hello, this is an informa0onal log. Value = %d", value); 

} 

Output would be: 

I (5744331) example: Hello, this is an informa0onal log 42 

Status bar 
The status bar at the bo$om of ESP-IDF on VSCode has the following features: 

1. Select ESP-IDF version to use 

2. COM port to use for uploads and output from the ESP32xx MCU 

3. Target MCU 

4. Select, or view, current project folder 

5. SDK Configura0on editor (menuconfig) 

6. Full clean of project 

7. Build project 

8. Choose flash method e.g. JTAG, UART or DFU (Device Firmware Update) 

a. DFU uses the na0ve USB interface on e.g. GPIO19 & 20 



b. The ESP32xx chip needs to be in bootloader mode before it can be detected as a DFU device and 

flash. This can be achieved by pulling GPIO0 down (e.g., pressing the BOOT bu$on), pulling RESET 

down for a moment, and releasing GPIO0. 

c. h$ps://blog.espressif.com/dfu-using-the-na0ve-usb-on-esp32-s2-for-flashing-the-firmware-

b2c4af3335f1 

d. A complicated method with no obvious benefits. 

9. Monitor device - opens a terminal using the COM port selected in point 2. 

10. Debug - starts debugging and stops at the line void app_main(void) 

11. Build, flash & monitor – does exactly that! 

12. Open ESP-IDF terminal – for entering command e.g. 

a. python –version 

b. idf.py –version 

c. idf.py menuconfig 

13. Execute custom task – does not seem to do anything? 

14. Problems – shows any reported 

15. Port forwarding – see: h$ps://code.visualstudio.com/docs/editor/port-forwarding 

16. Select and start debug configura0on – choose from available debuggers. 

17. PlaeormIO Home – only because PIO extension is also installed. 

18. Select current build variant. 

19. Change the ac0ve kit. 

20. Other items to the right are either not used or for PlaeormIO 

Run Python commands 
See point 12 above i.e. the only terminal where commands like idf.py build may be executed is in the ESP-IDF 

terminal, which is started from the bu$on on the status bar. 

Someone on the Espressif forum suggested installing python3 -m pip install virtualenv but this does not seem to 

affect anything. 

Example projects 
Are located in the ESP-IDF folder e.g. C:\ESP-IDF\esp-idf-v5.3\examples and can be viewed for project crea0on by 

clicking the ESP-IDF Explorer icon in the leX pane beneath PlaeormIO, the clicking “Show examples” in the 

COMMANDS sec0on at the top. 

 

Arduino as a component 
NOTE: This may not be working on newer version of ESP-IDF? 

To use Arduino libraries and code structures and commands the Arduino component must be installed. 

Go to command pale$e (Ctrl+ShiX+P), type “add arduino” to select “ESP-IDF Add Arduino ESP32 as ESP-IDF 

Component” command and click on it. 

This will create a “components” folder inside your program folder and download the arduino component. If for some 

reason the arduino component isn’t copied to the folder then go to h$ps://github.com/espressif/arduino-esp32 hit 

“Code” then “Download zip”, unpack and copy all content of arduino-esp32-master folder into the components 

folder, which will then magically appear as “components\arduino” when it is expanded to show the contents; it 

seems to read the contents of the folder and adjust the name presented accordingly.  The rename is maintained even 

aXer the folder is de-expanded! 



h$ps://www.youtube.com/watch?v=hHzGX-K6lmo 

h$ps://www.youtube.com/watch?v=7wOpKfeLd7w 

h$ps://simplediycircuits.wordpress.com/2023/06/25/migrate-arduino-esp32-project-to-esp-idf-in-visual-studio-

code-with-user-libraries-to-part-

1/#:~:text=S0ll%20you%20don't%20have,and%20download%20the%20arduino%20component 

arduino-esp32 is at: h$ps://github.com/espressif/arduino-esp32 but it is odd that when downloaded from GitHub via 

h$p the size is about 50Mb but if using Git clone it is over 2Gb! 

How to use Arduino as an ESP-IDF component is here: h$ps://docs.espressif.com/projects/arduino-

esp32/en/latest/esp-idf_component.html but I have yet to get it working. 

Note: Git clone downloads can be slow and unreliable, just persevere, or if you can download the zip from GitHub via 

HTTP, unzip and place in the components/arduino folder.  Git clone cannot be restarted, you'll need to rm -rf folder-

name where folder name is the name of the folder you are trying to clone, and then restart the clone from the 

beginning. 

Keyboard commands 
1. Ctrl ShiX P = open command pale$e 

2. Ctrl ShiX F = search 

3. ShiX Alt F = format document 

Useful code bits 
1. esp_restart(); 

a. Stops all running tasks 

b. Resets all peripherals 

c. Reboots the CPU 

Problems and solu"ons 

1. Build fails oXen with Ninja error = try CLEAN and also re-select the target e.g. esp32s3 

2. Some esp32sx modules do not reset aXer upload = press RESET bu$on on module 

3. JTAG upload fails = change upload to UART, upload then change back to JTAG 

Web resources 
1. Get started with ESP-IDF v5.3.1: h$ps://docs.espressif.com/projects/esp-idf/en/v5.3.1/esp32/get-

started/index.html 

2. Install ESP-IDF on VSCode: h$ps://github.com/espressif/vscode-esp-idf-

extension/blob/master/docs/tutorial/install.md 

3. Manual installa0on of ESP-IDF tools: h$ps://docs.espressif.com/projects/esp-idf/en/v5.3.1/esp32s3/get-

started/windows-setup.html# 



4. ESP-IDF downloads page: h$ps://dl.espressif.com/dl/esp-idf/?idf=5.3.1 

5. Install ESP-IDF extension on VSCode: h$ps://github.com/espressif/vscode-esp-idf-

extension/blob/master/docs/tutorial/install.md 

6. Use ESP-IDF extension on VSCode: h$ps://github.com/espressif/vscode-esp-idf-

extension/blob/master/docs/tutorial/basic_use.md 

7. Configure ESP32-S3 built-in JTAG Interface: h$ps://docs.espressif.com/projects/esp-

idf/en/v5.0.7/esp32s3/api-guides/jtag-debugging/configure-buil0n-jtag.html 

8. Start a project: h$ps://docs.espressif.com/projects/esp-idf/en/v5.3.1/esp32s3/get-started/windows-

start-project.html 

9. IDF Frontend idf.py: h$ps://docs.espressif.com/projects/esp-idf/en/v5.3.1/esp32s3/api-guides/tools/idf-

py.html 

10. h$ps://docs.espressif.com/projects/esp-idf/en/stable/esp32s3/get-started/establish-serial-

connec0on.html 

11. h$ps://docs.espressif.com/projects/esp-idf/en/stable/esp32s3/api-guides/jtag-debugging/index.html 

12. h$ps://github.com/espressif/vscode-esp-idf-extension/blob/master/docs/C_CPP_CONFIGURATION.md 

13. h$ps://docs.espressif.com/projects/esp-idf/en/v3.3.5/api-guides/jtag-debugging/setup-openocd-

windows.html 

14. h$ps://docs.espressif.com/projects/esp-idf/en/v3.3.5/api-guides/jtag-debugging/index.html#jtag-

debugging-configuring-esp32-target 

15. h$ps://github.com/espressif/idf-env/releases/tag/v1.2.31 

16. h$ps://docs.espressif.com/projects/esp-idf/en/stable/esp32/api-guides/tools/idf-component-

manager.html 


